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Adobe Creative Cloud gives you everything you need to create your best work. 
With it you can deliver eye-catching digital images and graphics that remain 
crisp when scaled. You can also lay out high-impact printed pages with exqui-
site typography, build HTML5/CSS3 websites that look great on any screen, 
and design applications for tablets and smartphones. 

This Classroom in a Book introduces you to the key elements and applications 
of Adobe Creative Cloud in a design workflow.

About Classroom in a Book
Design with Adobe Creative Cloud Classroom in a Book is part of the official 
training series for Adobe graphics and publishing software developed with the 
support of Adobe product experts. Each lesson in this book is made up of a 
series of self-paced projects that give you hands-on experience using the fol-
lowing Adobe products: Adobe Photoshop CC, Adobe Illustrator CC, Adobe 
InDesign CC, Adobe Muse CC, Adobe Acrobat XI Pro, and Adobe Bridge CC.

Design with Adobe Creative Cloud Classroom in a Book uses lesson files that 
are available online along with additional learning resources. To use these files, 
see “Accessing the Classroom in a Book files” later in this chapter.

Prerequisites
Before you begin working on the lessons in this book, make sure that you and 
your computer are ready.

Computer requirements
You’ll need about 1.2 GB of free space on your hard drive to store all of the lesson 
files and the work files that you’ll create as you work through the exercises.

Getting Started
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Required skills
The lessons in this book assume that you have a working knowledge of your com-
puter and its operating system. Make sure that you know how to use the pointer 
and the standard menus and commands, and also how to open, save, and close 
files. In addition, you should know how to use context menus, which open when 
you right-click/Control-click items, and scroll (vertically and horizontally) within a 
window to see content that may not be visible in the displayed area.

If you need to review these basic and generic computer skills, see the documenta-
tion included with your Microsoft Windows or Apple OS X software.

Installing Adobe Creative Cloud
Before you begin using Design with Adobe Creative Cloud Classroom in a Book, 
make sure that your system is set up correctly and that you’ve installed Adobe 
Creative Cloud. You must purchase an Adobe Creative Cloud subscription sepa-
rately. For system requirements, see www.adobe.com/products/creativecloud/tech-
specs.html#requirements.

Once you’ve begun your Creative Cloud subscription and installed the Creative 
Cloud desktop application, you can then install any of the software required for this 
book using the Apps tab in the Creative Cloud desktop app.

Because this book focuses on design, it does not use every Adobe Creative Cloud 
application. You need to install only the applications for the lessons you plan to 
complete.

Applications used in the lessons
Lesson

1 2 3 4 5 6 7 8 9 10*
Adobe Bridge CC • • • • •
Adobe Photoshop CC • • • • •
Adobe Illustrator CC •
Adobe InDesign CC • • • • • •
Adobe Acrobat Pro XI • •
Adobe Muse CC • •

* Lesson 10 is available online from peachpit.com along with the downloadable les-
son files for this book (see “Downloading the Classroom in a Book files”).

http://www.adobe.com/products/creativecloud/techspecs.html#requirements
http://www.adobe.com/products/creativecloud/techspecs.html#requirements
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Downloading the Classroom in a Book files
To work through the projects in this book, you’ll need to download the lesson files 
from peachpit.com. You can download the files for individual lessons, or download 
them all at one time.

To access the Classroom in a Book files:

1	 On a Mac or PC, go to www.peachpit.com/redeem and enter the code found at 
the back of your book.

2	 If you do not have a Peachpit.com account, you will be prompted to create one.

3	 The downloadable files will be listed under the Lesson & Update Files tab on 
your Account page.

4	 Click the lesson file links to download them to your computer.

5	 Any ZIP files you download are compressed, so double-click to decompress 
them before beginning the lessons. When decompressed, they will appear as 
folders containing lesson files.

Checking for Updates
Adobe periodically provides software updates. To check for updates in any pro-
gram, go to the Help menu and choose Updates. For book updates and bonus mate-
rial, visit your Account page on Peachpit.com.

Additional Resources
Design with Adobe Creative Cloud Classroom in a Book is not meant to replace 
documentation that comes with the program or to be a comprehensive reference 
for every feature. Only the commands and options used in the lessons are explained 
in this book. For comprehensive information about program features and tutorials, 
please refer to these resources:

Adobe Creative Cloud Help and Support: At helpx.adobe.com/creative-cloud/
topics/getting-started.html you can find and browse Help and Support content on 
adobe.com.

Adobe Creative Cloud Learning: helpx.adobe.com/creative-cloud/tutorials.html 
provides inspiration, key techniques, cross-product workflows, and updates on new 
features. The Creative Cloud Learn page is available only to Creative Cloud members. 

Adobe Forums: forums.adobe.com lets you tap into peer-to-peer discussions, 
questions and answers on Adobe products.

http://www.peachpit.com/redeem
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Adobe TV: tv.adobe.com is an online video resource for expert instruction and 
inspiration about Adobe products, including a How To channel to get you started 
with your product.

Adobe Design Center: www.adobe.com/designcenter offers thoughtful articles 
on design and design issues, a gallery showcasing the work of top-notch designers, 
tutorials, and more.

Adobe Developer Connection: www.adobe.com/devnet.edu.html is your source 
for technical articles, code samples, and how-to videos that cover Adobe developer 
products and technologies.

Resources for educators: www.adobe.com/education.edu.html includes three free 
curriculums that use an integrated approach to teaching Adobe software and can 
be used to prepare for the Adobe Certified Associate exams.

Also check out these useful links:

Adobe Marketplace & Exchange: adobeexchange.com is a central resource for 
finding tools, services, extensions, code samples, and more to supplement and 
extend your Adobe products.

Adobe Creative Cloud home page: creative.adobe.com is the page where you can 
sign into Creative Cloud, so that you can gain access to Creative Cloud services and 
application downloads.

Adobe Labs: labs.adobe.com gives you access to early builds of cutting-edge tech-
nology, as well as forums where you can interact with both the Adobe development 
teams building that technology and other like-minded members of the community.

Adobe Certification
The Adobe training and certification programs are designed to help Adobe custom-
ers improve and promote their product-proficiency skills. There are four levels of 
certification:

•	 Adobe Certified Associate (ACA)

•	 Adobe Certified Expert (ACE)

•	 Adobe Certified Instructor (ACI)

•	 Adobe Authorized Training Center (AATC)

The Adobe Certified Associate (ACA) credential certifies that individuals have the 
entry-level skills to plan, design, build, and maintain effective communications 
using different forms of digital media.

The Adobe Certified Expert program is a way for expert users to upgrade their 
credentials. You can use Adobe certification as a catalyst for getting a raise, finding 
a job, or promoting your expertise. 

http://www.adobe.com/designcenter
http://www.adobe.com/devnet.edu.html
http://www.adobe.com/education.edu.html


If you are an ACE-level instructor, the Adobe Certified Instructor program takes your 
skills to the next level and gives you access to a wide range of Adobe resources.

Adobe Authorized Training Centers offer instructor-led courses and training 
on Adobe products, employing only Adobe Certified Instructors. A directory 
of AATCs is available at partners.adobe.com.

For information on the Adobe Certified programs, visit training.adobe.com/ 
certification.html.
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Everything you need to create your best work
Creative work crosses more boundaries than ever. Projects can be 
cross-media, possibly destined for print, web, and video. They can be 
cross-platform, appearing on computers, tablets, and smartphones. 
And they can be collaborative, with team members spread across 
cities or countries.

Access to the entire collection of Creative Cloud tools helps you solve 
any creative problem. Solutions such as Adobe Digital Publishing 
Suite, Single Edition and Adobe Muse greatly simplify publishing 
content on new media platforms. Take advantage of the Creative 
Cloud website (creative.adobe.com) and integration with the Behance 
creative community to easily share your work with project colleagues 
or potential clients.

Adobe Creative Cloud
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Adobe Creative Cloud helps you meet your workflow 
challenges by providing you with the tools to create, 
work together, share, and publish.
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Create professional graphics and type
A design project typically involves many components, including images, drawings, 
text, interactivity, and dynamic media, such as video and audio. Creative Cloud 
brings together graphics, type, and color tools that you can use to create or edit a 
wide range of media for any creative project.

Edit images precisely with Photoshop CC
Adobe Photoshop CC offers more speed, power, and freedom to create compel-
ling images as the standard in professional, image editing software. You can start 
from a digital camera image and create digital paintings with flexible brush tools or 
graphics for websites. You can also use intelligent editing tools to create compos-
ite images by combining elements, correct lens curvatures and other distortions, 
create photographic blur effects, straighten images in seconds, create 360-degree 
panoramas, extend depth of field, and more.

Adobe Camera Raw 8, included with Photoshop CC, lets you edit the raw formats 
of many digital cameras and provides improvements that help you heal images, fix 
perspective distortions, and create vignettes. In addition, in Photoshop CC, Adobe 
Camera Raw is available as a filter you can apply to any layer.

Photoshop includes robust Save for Web tools for optimizing your images for 
any medium, from print to online to mobile. You can share images directly 
from Photoshop to Behance so you can showcase your work or get feedback 
from colleagues.

Because digital video has become an essential part of many creative projects, you 
can use Photoshop to edit video with a designer-friendly user interface. You’ll edit 
a video in Photoshop in Lesson 5, “Creating a Video with Photoshop.”
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Create scalable designs and drawings with Illustrator CC
When you want to create drawings, designs, logos, and patterns that scale easily 
as vector graphics, Adobe Illustrator CC provides a deep set of tools so you can 
develop ideas quickly and precisely. You can use Image Trace to convert photos 
or other images into vector artwork, create smooth-edged shapes using precise 
drawing tools, or paint with brush strokes you can edit. The type tools in Illustrator 
support advanced typography, and you can develop logos and other designs based 
on font characters you’ve converted to paths.

The ability to create multiple artboards of different sizes lets you work out multiple 
variations or iterations of your design projects in a single Illustrator document. For 
example, you can design a set of business stationery that includes a business card, 
letterhead, and envelope, and store them all in the same Illustrator file.

As in Photoshop, you can prepare your Illustrator graphics for the web or mobile 
devices using Save for Web optimization tools, and you can share your Illustrator 
projects directly to Behance for self-promotion or feedback.
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Gain access to thousands of fonts with TypeKit
Your Creative Cloud subscription gives you access to thousands of valuable fonts 
through Adobe TypeKit, making it much easier and faster for you to find the per-
fect font. You can use Adobe TypeKit fonts directly from Adobe Muse.

Create color schemes with Adobe Kuler
Adobe Kuler lets you create color themes in some Creative Cloud applications, 
using an iPhone or using your web browser. The Adobe Kuler iPhone app lets you 
capture color schemes from whatever is in front of you (such as a garden or a street 
scene), or you can design your own color scheme using the Kuler app or website 
(kuler.adobe.com). You can use Creative Cloud to sync your Kuler color schemes 
between Creative Cloud applications, the Kuler website, and Adobe apps. The 
Kuler website is also a great place to explore color themes shared by others.

P	Note:   As this book 
is being written, Adobe 
plans to let you use 
TypeKit fonts with 
any of your desktop 
applications by syncing 
them to your desktop. 
For the current status of 
this feature, check your 
Creative Cloud desktop 
app for updates: This 
app will be used to 
enable the desktop font 
sync feature.
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Design publications for print 
and mobile devices
Once you have completed the components for your design projects, you need to 
integrate them into a finished, polished piece. Creative Cloud provides the essential 
pieces that complete your design workflow.

Create print and online documents with Adobe InDesign CC
As a hub for publication design and production, InDesign is where everything 
comes together: With InDesign, you can lay out pages that include content, such 
as images from Adobe Photoshop CC, scalable artwork from Adobe Illustrator CC, 
and styled text from your word processor. You can create documents many pages 
long that remain easy to maintain and revise thanks to production-strength tools 
for text and graphics.

With deep roots in high-end print publishing, the powerful and precise layout 
features in InDesign help you meet the highest professional standards of creative 
design, typography, production, and final output. The sophisticated layout capabili-
ties in InDesign now drive digital publishing—from fast and efficient output of PDF 
files and EPUB ebooks to the ability to work directly with Adobe Digital Publishing 
Suite to create book apps for tablets and smartphones. Liquid Layout rules, 
Alternate Layouts, Linked Content, and the Content Collector greatly simplify 
creating and maintaining layouts for multiple devices from one publication.
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Produce professional-quality PDF files 
with Adobe Acrobat XI Pro
Adobe Creative Cloud includes Adobe Acrobat XI Pro because the Adobe Portable 
Document Format (PDF) plays a central role in many design workflows. With 
Adobe Acrobat XI Pro, you can create and edit professional PDF files for delivery 
of print design projects for final output on press, and for sharing and distributing 
documents or interactive titles online.

Although Creative Cloud applications such as InDesign, Illustrator, and Photoshop 
make it easy to create full-featured interactive or press-ready PDF files on their 
own, Acrobat XI Pro is valuable when you want to perform further enhancement, 
management, and optimization, such as combining multiple PDF files and reducing 
the file size of the combined file.

If you design print publications, Acrobat XI Pro integrates smoothly with the print 
production features in Adobe InDesign CC, such as color management and CMYK 
support, and with long document features, such as a hyperlinked index and table 
of contents. If you create online documents for desktop or mobile devices, you 
can use Acrobat Pro to design interactive forms, protect sensitive information, 
add media (such as video and audio), and include multiple types of materials in 
one file. You can also organize and track online reviews of shared documents and 
collect comments.

Share work with your community
Design is typically a collaborative activity between designer, client, and community, 
and that collaboration increasingly happens online. Adobe Creative Cloud supports 
online collaboration through features such as the Behance online creative commu-
nity and file syncing.

Get connected with Behance
Adobe Creative Cloud gives you direct access to the Behance creative community 
where you can showcase your work, get feedback, and find creative inspiration. 
Behance provides you with a way to reach out beyond your local community and 
connect with top creatives around the world.

Creative Cloud applications streamline your connection to Behance. Instead of hav-
ing to switch to a web browser to work with Behance, you can upload your work 
directly from applications, such as Adobe Photoshop CC and Adobe Illustrator CC, 
and you can monitor your Behance activity stream directly in the Creative Cloud 
desktop app. You can display your work publicly or to a specific audience and get 

P	Note:  As this 
book is being written, 
Adobe plans to 
integrate Behance 
with more Creative 
Cloud applications. 
For the current status 
of this feature, check 
your Creative Cloud 
desktop app for 
application updates. 
Applications integrated 
with Behance have 
a Share on Behance 
command (File > Share 
on Behance).
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the feedback you need to improve your work. Behance includes direct connections 
to social media like Twitter and Facebook to help you promote your work online.

Privately share files with Creative Cloud online storage
Your Adobe Creative Cloud account provides you with online file storage and 
sharing. You can upload and share files through a web browser. Storing files online 
makes it easier for you to work anywhere, and the ability to share files privately 
makes Creative Cloud storage useful for collaboration.

P	Note:  As this 
book is being written, 
Adobe plans to let 
you synchronize files 
on your desktop with 
Creative Cloud online 
file storage so that you 
don’t have to manually 
upload and download 
them. For the current 
status of this feature, 
check your Creative 
Cloud desktop app 
for updates.
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Create customized websites 
for your work or clients
Sharing your work on your own website is essentially required in today’s design 
world, but building a website can require skills, time, and energy that draw you 
away from your creative projects. Adobe Creative Cloud provides several ways to 
create personalized websites without writing code, depending on what you need.

Show your best work in a ProSite portfolio
You can create a professional public portfolio easily and quickly using ProSite, a 
pro-level feature of Behance. In ProSite, portfolio creation begins by selecting a 
layout, customizing it, and adding projects. ProSite includes beautiful templates 
and powerful controls for personalizing the look of your portfolio, all within your 
web browser. When you’re ready to show your work to the world, click Publish. 
This example shows a portfolio containing one project; to see real-world examples 
of portfolios with many projects you can explore, visit www.behance.net.

You can link your Behance account to other social network accounts, including 
Twitter, LinkedIn, Google, and Facebook, so that it just takes an instant to promote 
any of your content from Behance. As you grow your Behance ProSite presence, 
you can monitor its effectiveness with built-in statistics reporting that includes 
project views and portfolio views over time.

http://www.behance.net
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Build your own website in Adobe Muse 
CC without writing code
If you want to create a fully customized website design, you can do it in Adobe 
Muse CC without writing code. Adobe Muse stands out from other website 
creation tools in that you can design websites using familiar tools and commands 
like those in Adobe InDesign CC. You can create your website by thinking like a 
designer, not a web programmer.

The design freedom Muse provides doesn’t compromise the technical quality of the 
site. Websites you create with Muse adhere to web standards, and you can easily 
create a single site with layouts customized for desktop computers, tablets, and 
smartphones. When you create mobile versions of a website, not only are they sized 
appropriately for the screen, but they also respond to touch gestures like swipes 
and pinches. These advantages help provide your site’s visitors with a positive expe-
rience, no matter how they view your site.

Adobe Creative Cloud also simplifies publishing and hosting of your website by 
providing you with Adobe Business Catalyst web hosting services. Your Creative 
Cloud subscription lets you use Business Catalyst to host up to five websites for 
you or your clients.

You’ll work with an Adobe Muse website in Lesson 3, “Creating a Mobile-Friendly 
Website.”
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Work flexibly, online or offline
Adobe Creative Cloud works for you whether or not you are connected to the 
Internet. When you’re connected to the Internet, you can take advantage of appli-
cation integration with Creative Cloud online tools. You can continue to work 
when you aren’t online because Creative Cloud applications are installed locally on 
your computer. You can store your files locally (on your own disks or servers) or in 
the online storage provided as part of your Creative Cloud account.

Manage project files using Adobe Bridge
With Adobe Bridge CC, you can manage your media with centralized access to all 
of your creative assets. Regardless of the Adobe Creative Suite software you use, 
your projects will likely involve various files and formats. You may be organiz-
ing documents and graphics from different sources or finding your way through 
a large media library. Adobe Bridge is an advanced media manager that helps you 
quickly locate and organize the files you need, and move them directly into the 
Adobe Creative Suite software you’re using. Adobe Bridge helps you work with 
images, text, the native file formats of Creative Suite software—such as Photoshop, 
InDesign, and Illustrator—videos, fonts, and more. Powerful searching, content fil-
ters, and thumbnail views help you zero in on the files you need, and large previews 
enable you to ensure that you’re opening the correct file. You’ll use Adobe Bridge in 
many lessons in this book.

Take your work anywhere
When you’re away from your computer, you can work on any other computer that 
meets the system requirements for Creative Cloud. Your subscription works on 
up to two computers, such as a desktop and a laptop, or even one Mac and one 
Windows computer. For example, you can work on a computer at a client’s office 
by signing into Creative Cloud, downloading the applications you need, and then 
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signing out when you’re done. This flexible licensing also makes it easy to stay on 
schedule on a secondary computer if your primary computer is out for repairs.

To save even more time, you can synchronize the settings of some applications 
to Creative Cloud. For example, you can sync Photoshop preferences, actions, 
brushes, and other settings to Creative Cloud. This makes it easy to set up your 
Photoshop customizations on another computer or to quickly restore your personal 
settings in case you have to reinstall Photoshop.

If you upload your project files to the online storage included with your Creative 
Cloud subscription, you’ll be able to download those files on another computer. 
Combined, the flexible licensing, settings synchronization, and online file storage 
give you the ability to liberate your work from your primary computer so you can 
complete it anywhere.

Get more training anytime
With all of the tools available to you through Creative Cloud, you’ll sometimes want 
to use an application or service that’s new to you. An extensive library of Creative 
Cloud training videos help you get up and running quickly when you encounter a 
Creative Cloud tool that’s unfamiliar. Immediate access to relevant training helps 
save time that you might otherwise spend searching for the right tutorial.

E	Tip:  To watch 
additional training 
videos about Adobe 
applications, visit 
tv.adobe.com.
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Expand your creative universe
Although you might initially use the Adobe Creative Cloud applications that 
focus on design, Creative Cloud gives you plenty of room to grow as you develop 
your career.

Photography
If you routinely work with photo shoots using Adobe Camera Raw, Adobe 
Photoshop, and Adobe Bridge, you might consider using Adobe Photoshop 
Lightroom. It’s optimized for precise processing and highly efficient organization 
of large numbers of photos and lets you easily create slide shows, videos, and books 
from your photographs.

Video editing and production
You can quickly create a video using the designer-friendly video-editing tools in 
Photoshop CC, as you will in Lesson 5, “Creating a Video with Photoshop.” If you 
feel like tackling more ambitious video projects, Creative Cloud provides profes-
sional video production tools as well, such as Adobe Premiere Pro CC, Adobe After 
Effects CC, Adobe Audition CC, and Adobe SpeedGrade CC.

Web development
Although ProSite and Adobe Muse are the best options for building websites if 
your focus is on design rather than coding, experienced web programmers can take 
advantage of a variety of advanced Adobe Creative Cloud web development tools, 
including Adobe Dreamweaver CC, Adobe Flash Professional CC, Edge Code CC, 
Edge Inspect CC, and Edge Reflow CC.
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Touch App plug-ins
If you use Adobe Touch Apps such as Photoshop Touch or Adobe Ideas on your 
smartphone or tablet, you can integrate them with Creative Cloud desktop apps 
using Touch App plug-ins. For example, by installing Touch App plug-ins, you can 
transfer an image you edited using Photoshop Touch from your tablet to Photoshop 
CC on your desktop. You can install the Touch App plug-ins from the Creative 
Cloud desktop app.

Let’s begin
Now that you’ve been introduced to the full range of applications and services that 
Creative Cloud offers, it’s time to jump into Lesson 1 and start learning about the 
Creative Cloud tools that will enhance your design workflow.
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Using Fonts with Adobe 
Creative Cloud

Lesson overview
The way you set up your documents and create your assets will affect 
how easily and efficiently you can design your work. This lesson will 
introduce you to some important skills and concepts:

•	 Understanding which font formats are best for print  
and web projects

•	 How to choose appropriate font types in various  
Creative Cloud applications

•	 Using TypeKit fonts

You’ll probably need less than one hour to complete this lesson. 
Download the project files for this lesson from the Lesson & Update 
Files tab on your Account page at www.peachpit.com and store them 
on your computer in a convenient location, as described in the “Getting 
Started” section of this book. Your Accounts page is also where you’ll find 
any updates to the chapters or to the lesson files. Look on the Lesson & 
Update Files tab to access the most current content. 

4

http://www.peachpit.com
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In this lesson you’ll learn about the different 
types of fonts that you can use with Adobe 
Creative Cloud.
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Choosing font formats for creative projects
Whether you’re new to digital fonts or a veteran of print and online publishing, the 
use of digital fonts has changed dramatically in recent years with new font formats 
and new ways to use them. Adobe Creative Cloud stays in step with these changes 
by providing a variety of fonts for print, online, and mobile use.

Fonts for printing
When you apply fonts to text in primarily print-oriented Adobe Creative Cloud 
software, such as Adobe Photoshop CC or Adobe InDesign CC (or your word 
processor), you typically use fonts that were designed to be installed and viewed 
on a desktop or laptop computer. These are the most established kinds of fonts for 
personal computers and are sometimes called system fonts or desktop fonts.

Several desktop font formats have been used for print publishing and general 
personal computer use over the last 20 years. The major font formats of this kind are:

•	 PostScript. The earliest high-quality fonts used for personal-computer-based 
print publishing were Adobe PostScript fonts. PostScript fonts made it possible 
to scale type to any size while preserving smooth curves and sharp edges.

•	 TrueType. The most common font format in use today is TrueType, which is 
now found on just about every Windows and Mac OS X system. TrueType is 
ubiquitous because it started out as an Apple font format and was later licensed 
by Microsoft; both companies made TrueType the standard font format for 
their operating systems.

•	 OpenType. As personal computers and publishing software became more 
powerful and typographical standards advanced, Microsoft and Adobe worked 
together to advance type capabilities beyond the limitations of the PostScript 
and TrueType font formats. This resulted in the OpenType font format, which is 
an open standard that makes it easier for more companies to create fonts.

A wide variety of inexpensive fonts are available in TrueType format. However, 
OpenType fonts are now favored by designers and publishers because of advanced 
typographic capabilities, such as true small caps and old-style figures, and better 
support for non-English glyphs. (A glyph can be a character or a combination of 
characters, such as a ligature.) Also, you can use the same font file on Windows and 
Mac OS X; whereas TrueType or PostScript fonts typically require font files specific 
to Windows and Mac OS X.

You can use any of these formats in Creative Cloud applications in Windows or 
Mac OS X. Many fonts are available in all three formats, although new professional 
fonts are most likely to appear in OpenType format. When you install Creative 
Cloud applications that support printing, a range of Adobe OpenType fonts are 
installed along with the application, and those fonts are available to all of the 
applications on your system.

P	Note:  If you 
have not already 
downloaded the project 
files for this lesson 
to your computer 
from your Account 
page, make sure 
you do so now. See 
“Getting Started” at the 
beginning of the book.



Design with Adobe Creative Cloud Classroom in a Book  157

Fonts for websites
Website projects involve font challenges that don’t exist for print. Because website 
layouts are not fixed, text may be scaled or reflowed as a web page is viewed on 
differently sized displays or browser windows. This is especially true today because 
website layouts are increasingly likely to automatically resize for large desktop 
displays and small tablet and smartphone displays. For website text to reflow as 
layouts adjust, the font must be present on the device where the website is being 
displayed. But all fonts are not present on all computers. If you used a font installed 
on your computer (a system font) in your design, but that font is not on the reader’s 
device, text on your website won’t appear as you intended because the reader’s web 
browser will substitute a font that is actually present on the device. Until recently, 
the solution to this display problem was to specify a font from the limited set 
installed on most computers, referred to as web safe fonts. Of course, using web-
safe fonts limits design flexibility because there are so few of them to choose from.

On websites where unique typography was a high priority, other approaches were 
to convert text to an image or to use browser plug-ins that could support high-
quality typography. However, images do not scale smoothly, cannot be searched or 
highlighted as text, and consume more bandwidth than text, which makes pages 
load more slowly. The disadvantage of browser plug-ins is that you can’t assume 
they’re installed with every web browser, and browser plug-ins are typically not 
available for mobile web browsers on smartphones and tablets—the fastest-growing 
area of mobile usage.

Fortunately, those workarounds are no longer necessary because you can now 
easily use high-quality fonts on websites thanks to advancements in web standards. 
Current web browsers can now download fonts from servers. So, if a font is not 
available on the viewing device, that font will simply be downloaded, and the web 
page text will be displayed as you designed it. In other words, fonts can now be 
linked by a URL and downloaded, similarly to how you can include images and 
videos on a web page by embedding URL links to them. The fonts that you can link 
to are called web fonts. When you use web fonts, they’re used only temporarily on a 
site visitor’s web browser and don’t become available to the rest of the system.

The most common web fonts are available in the following formats:

•	 OpenType or TrueType. It’s possible for some web browsers to download the 
same OpenType and TrueType fonts you would use for print projects, but those 
fonts are typically not compressed for high performance over networks.

•	 Web Open Font Format (WOFF). A WOFF font can be based on OpenType or 
TrueType but is optimized for fast downloading.

•	 Embedded OpenType (EOT). An EOT is a compressed Microsoft version of 
the OpenType font format.
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Although you can link to web fonts, you typically do not want to link them to fonts 
stored on your website the way you store images and other linked content. It’s often 
best to link to fonts provided by a web font service, such as Adobe TypeKit, which 
is included with your Adobe Creative Cloud subscription. Web font services are 
useful because there is no font format that works with all web browsers. A web 
font service can intelligently serve up whichever format works best for the browser 
that’s requesting the fonts. Another good reason to use web font services is that you 
don’t have to worry about font licensing issues; the fonts they serve are cleared for 
use as downloadable elements of websites.

The only disadvantage of web fonts is that they require up-to-date web browsers. 
Fortunately, browsers that are incompatible with web fonts are becoming less 
common and are now found mostly on very old systems. The web browsers on 
mobile devices typically support web fonts, which makes web fonts a practical 
and current solution that lets you design websites with access to a wide range 
of high-quality fonts.

Using fonts with Adobe Creative Cloud
Whether you’re designing for print, web, or video, Adobe Creative Cloud makes 
more fonts accessible to you. When you install Creative Cloud design applications, 
such as Photoshop CC or InDesign CC, a set of professional OpenType fonts is 
installed along with the software, and you can use those fonts with any application 
on your system. These OpenType fonts are system fonts that are appropriate for 
print projects but are not ideal for text on web pages. For web design projects, you 
may want to use the Adobe TypeKit web fonts that are included with your Adobe 
Creative Cloud subscription.

If you build a website by hand coding it, using a web font involves adding 
appropriate font code in the correct line in your website’s CSS code. That isn’t 
necessary when you build your website in designer-friendly Adobe Muse, because 
the integration of Adobe Muse with Adobe TypeKit lets you choose and apply web 
fonts to your website by pointing and clicking instead of writing code.

As an additional benefit, some TypeKit fonts are also available for desktop use. 
When you use the Adobe Creative Cloud desktop application to select TypeKit 
desktop fonts and sync them to your computer, those fonts are installed on your 
system and become available to all applications on your system.

In combination, the OpenType fonts installed with Creative Cloud applications and 
the Creative Cloud access to Adobe TypeKit web and desktop fonts provide you with 
immediate access to a wide selection of typefaces for your print and web projects.
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Choosing desktop fonts in Creative Cloud applications
In Photoshop, InDesign, and other Adobe Creative Cloud design applications, you 
might notice that the Type menu looks different than it does in other software you 
may use. The reason is that the Type menu in Creative Cloud software is enhanced 
to help you choose an appropriate font for your output medium. In applications 
that are often used for print, the font menu includes a symbol near the font name 
that indicates the format of each font, like this: 

	 OpenType

	 Adobe PostScript

	 TrueType 

Also, to the right of the font name, you may see a visual sample of the font.

The format of a font does not necessarily guarantee its suitability for a particular 
purpose, but there are some guidelines you can follow. TrueType fonts are best 
for printed projects, video, and online presentations. For print projects in which 
professional typography is a priority, OpenType and PostScript fonts are preferred. 

The same font can exist in many versions created by various type foundries 
(companies that design and produce fonts). Some sources of fonts, such as the 
Adobe Type Library, aspire to higher levels of typographic quality, so their versions 
of fonts will typically exhibit a high level of quality in subtle design details and may 
contain additional specialized glyphs. If a font exists in OpenType and PostScript 
formats, the OpenType version will typically be more recent and possibly more 
refined; however, when you’re deciding between multiple versions of the same font, 
you should always consider the reputation of each type foundry.
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Viewing document fonts in Adobe Bridge
You can use Adobe Bridge to inspect the fonts used in some document formats 
created by Adobe Creative Cloud applications, such as Adobe InDesign and Adobe 
Illustrator. If Adobe Bridge can display the fonts inside a document, they’ll be listed 
in the Fonts section in the Metadata panel. As a result, you can find out which fonts 
a document uses without having to open and manually examine it.

Choosing fonts for a website in Adobe Muse
In contrast with print design applications, Adobe Muse was introduced to create 
website design. Instead of prioritizing fonts that provide the highest quality for 
print, Muse prioritizes web fonts because you can reasonably expect web fonts to 
appear as you intended when your website is viewed in current web browsers.

The font menu in Muse contains a Recently Used Fonts section for quick access to 
fonts you have recently applied. Below that section you’ll see three font sections in 
order of preference for website design:

•	 Web Fonts. The Web Fonts menu offers the largest choice of fonts that you 
can expect to display as intended when visitors view your website. The fonts in 
this menu are either present in the open Muse website or added by you, so this 
menu may be empty if you haven’t yet used any web fonts. To customize the 
Web Fonts menu, see the next section, “Working with Adobe TypeKit web fonts 
in Adobe Muse.”
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•	 Web Safe Fonts. Only a 
small number of fonts are 
web safe, so they don’t 
provide much design 
freedom. But because web 
safe fonts are installed on 
most devices, if you use 
one, you can reasonably 
expect your website to 
display these fonts as 
you intended.

•	 System Fonts (exports as 
image). Muse lists system 
fonts at the bottom of the 
menu because they are 
installed on your computer 
but probably not on the 
computers of visitors who 
view your website, and 
they are not equipped to be 
automatically downloaded 
because they aren’t web 
fonts. If you do choose 
one of these fonts, Muse 
converts the text to an 
image at a fixed size, which 
is typically not desirable, 
as described in “Fonts for 
websites,” earlier in this lesson. For all of these reasons, system fonts are the 
least attractive font choice for websites.

Working with Adobe TypeKit web fonts in Adobe Muse
In Adobe Muse you can apply fonts using a menu in the toolbar or a menu in the 
Text panel. The items listed in the font menu’s Web Fonts section can vary, because 
that section can contain web fonts used in the currently open document as well as 
web fonts you’ve added manually to the menu.

You added and applied a web font in Lesson 3; now you’ll take a closer look at the 
Add Web Fonts dialog box.

1	 Make sure your computer is connected to the Internet, and start Adobe Muse CC.

2	 In Windows Explorer, Mac OS X Finder, or Adobe Bridge CC, navigate to 
your Lessons folder, open the Lesson04 folder, and then double-click the file 
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Pluralist-site-04.muse. The file opens in Adobe Muse CC. If Muse asks you if 
you want to update links, click Cancel.

3	 In the site map, double-click the page Log in/Join to open it in Design view.

4	 With the Text tool (  ), click a text insertion point anywhere in the Log in/Join 
text frame. This activates the text options in the Muse toolbar and in the Text 
panel, including the font menu.

5	 Click the font menu in the Muse toolbar or in the Text panel. You’ll see two 
fonts, Frijole and Varela. Both are listed because they are used in the document. 
Frijole is used on the home page, and Varela is the font used throughout the rest 
of the site.
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If you opened another Muse website that used a different set of web fonts, those 
would be the fonts listed in the Web Fonts section.

When you want to use web fonts that aren’t already listed in the Web Fonts section 
or when you want to remove unused fonts from the list in the Web Fonts section, 
you use the Web fonts dialog box.

1	 In a font menu, choose Add Web Fonts.

Across the top of the Web Fonts dialog box are controls for viewing the fonts 
and helping you filter the list to more easily find the fonts you want to add.

2	 Click in the Filter By Name field and type pol. All of the fonts disappear except 
for Poller One and Poly because you’ve just filtered the font list to display only 
the fonts containing the letters “pol” in the name.

3	 Click the Poller One font. A blue check mark appears. The Poller One font is 
now selected and available in the font menu, but you aren’t finished yet. You can 
add more than one font before you close the Add Web Fonts dialog box.
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4	 Delete the text in the Filter By Name field.

5	 Move the mouse over the first icon in the Filter section, and then pause to 
display the tool tip. It reads “Sans serif: without serifs” to describe which fonts 
will be displayed if you click the button.

6	 Move the mouse over the second icon in the Filter section, and then pause to 
display the tool tip. It reads “Serif: with serifs” to describe which fonts will be 
displayed if you click the button.

7	 Click the Serif: with Serifs button.

8	 Scroll all the way to the bottom of the list of displayed fonts, and click the 
Ribeye and Tinos fonts to add those to the fonts you’ve selected.
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9	 Click the third button from the right; the list now displays just a few fonts. Click 
the second button from the right to see that a different short list of fonts is 
displayed. Hover the mouse over each of those buttons to read their tool tips.

Notice that the two buttons you used in step 9 are in their own group. 
According to the tool tips, the first of the two buttons in that group filters the 
list for fonts that work well as headings, and the second filters the list for fonts 
that work well in paragraphs at small sizes. These are only suggestions; you can 
use a font in any way you like.

10	Click the check mark button at the right end of the filter bar to display fonts 
you’ve selected during this session.

The font list may be blank. The reason is that the list displays fonts that meet all 
the filter criteria, and there may be no selected fonts that match the style, usage, 
and selection filter buttons that are active.

11	If the heading or paragraph usage button is selected, deselect it. The list should 
now display the Ribeye and Tinos fonts. You selected one more font earlier, but 
it isn’t displayed because the Serif filter is active.
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12	Click the Serif button to deselect it. Now you see all three of the fonts you 
selected during this session. Poller One wasn’t displayed earlier because it is a 
sans serif font. If there were other web fonts previously added to the Web Fonts 
section, they would also appear in this list.

13	Click OK. If a Web Fonts Notification alert appears, click OK.

14	Click a font menu. The Poller One, Ribeye, and Tinos fonts are now part of the 
Web Fonts menu.
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15	Choose File > Add/Remove Web Fonts. This is another way to open the Add 
Web Fonts dialog box.

16	Make sure the Show Selected Fonts button (the check mark button) is selected, 
and click the Ribeye font. It becomes deselected and disappears.

17	Click OK. If a Web Fonts Notification alert appears, click OK.

18	Click a font menu, and notice that Ribeye is no longer available.

Congratulations! You’ve learned how to work with web fonts in Adobe Muse. 
Now you can apply a wide range of Adobe TypeKit fonts to your websites and be 
confident that they’ll display as you intended in current web browsers.

Wrapping up
Adobe Creative Cloud greatly simplifies the process of choosing appropriate fonts 
for design projects that target different media. You can take advantage of the fonts 
installed with Creative Cloud for your print, video, and interactive projects. If you 
design websites with Adobe Muse, you can easily add and use a wide range of web 
fonts for design flexibility.



168  Lesson 4  Using Fonts with Adobe Creative Cloud

Review questions
1	 What are the three font formats traditionally used for print publishing and general 

computer use?

2	 How can you find out which fonts were used in an Adobe InDesign or Adobe 
Illustrator document without opening the document?

3	 What are the three types of fonts that can potentially be specified for text on a 
web page?

4	 Of the three types of fonts you can potentially specify for web page text, which one 
is the best and for what two reasons?

5	 How do you add or remove web fonts from the font menu in Adobe Muse?

Review answers
1	 OpenType, PostScript, and TrueType are the three font formats traditionally used for 

print publishing and general computer use.

2	 Select an Adobe InDesign or Adobe Illustrator file in Adobe Bridge, and look at the 
Fonts section in the Metadata panel.

3	 Web fonts, web safe fonts, and system fonts can potentially be specified for text on a 
web page.

4	 Web fonts are the best choice for websites because they provide a wider range of font 
choices than web safe fonts and can be automatically downloaded to a website visitor’s 
web browser.

5	 Click Add Fonts in the font menu or choose File > Add/Remove Web Fonts to open the 
Add Web Fonts dialog box. In the dialog box you can choose from all fonts available in 
Adobe TypeKit.
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Index

online storage, 13
subscription, 126, 151, 158, 176, 206
synchronizing application settings, 17
training videos for, 17, 221
using fonts with, 158–167
using video in, 176, 179
website hosting, 15

Adobe Digital Editions
installing, 236
preparing documents for EPUB export, 

239–253
viewing documents in EPUB format, 

237–239
Adobe Dreamweaver CC, 18
Adobe Encore, 179
Adobe Flash Professional CC, 18
Adobe ID, 221, 225, 226, 230
Adobe Ideas app, 19
Adobe Illustrator CC

adding logo to video, 189–191
artboards, 26–32
creating business stationery, 26–40
overview, 9
package design mockup, 41–51

Adobe InDesign CC. See InDesign CC
Adobe Kuler app, 10
Adobe Media Encoder CC, 179
Adobe Muse CC

choosing website fonts, 160–161
compact menus for phone layout, 

135–140
considerations, 126, 158
creating websites, 15, 132–134
described, 126
designing websites, 126–150
features, 15
form creation, 146–150
in-browser editing, 152
mobile version of website, 132–134
parallax scrolling effect, 130–132

Symbols

3D motion effect, 131
720p video, 280
1080P video, 177, 201, 212, 279, 280

A

Accordion widget, 146–150
Acrobat XI Pro, 122, 258, 262–263
action-safe area, 182
Add Phone Layout dialog box, 132
administrative page, 152
Adobe Acrobat XI Pro, 122, 258, 262–263
Adobe After Effects CC, 176, 179
Adobe Audition CC, 179, 200
Adobe Bridge CC

adding folders to Favorites, 22
collections, 174–175, 178, 180, 189
enlarging thumbnails, 68
exporting images for online media, 

282–287
finding documents, 68
managing project files, 16
Mini Bridge, 71–72, 90, 296
opening files in, 69, 287
organizing work with, 22–25
presets, 25
sorting by filename, 172
viewing documents, 68–69
viewing fonts, 69, 160
viewing linked files, 69

Adobe Business Catalyst, 126, 128, 151–152
Adobe Camera Raw, 8, 282–287. See also 

raw images
Adobe Content Viewer

previewing apps, 214–215, 228
viewing folios, 224, 225, 228–230

Adobe Creative Cloud
desktop apps, 19
multiple computers and, 16
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Plan view, 127, 128, 129, 133
publishing websites, 15, 151–152
TypeKit fonts and, 10, 161–167
working with, 127–130

Adobe Photoshop CC. See Photoshop CC
Adobe Photoshop Lightroom, 18
Adobe Prelude CC, 179
Adobe Premiere Pro CC, 176, 179
Adobe Reader, 262, 266
Adobe SpeedGrade CC, 179
Adobe Story CC Plus, 179
Adobe Touch App plug-ins, 19
Adobe TypeKit

considerations, 10, 158, 215
web fonts, 130, 161–167

After Effects CC, 176, 179
animating video, 192–198
App Store

considerations, 206
membership, 225
publishing apps via, 225
submitting apps to, 225

App Store apps, 213
apps. See also DPS

App Store distribution, 213, 225
App Store vs. iBooks documents, 213
Creative Cloud desktop apps, 19
iPad/iPhone. See iPad/iPhone apps
platforms, 206

artboard guides, 30
artboards, 9, 26–32
Articles panel, 241–248
aspect ratio, 93, 181, 195, 198
assets, 127
audio

muting, 200
using in video, 179, 198–200

audio files, 211–212
Auto-Fit settings, 89, 95, 106, 108

B

Background layer, 52, 85
backgrounds

color, 64
removing in Photoshop, 72–79
for social media, 51–64

Behance creative community, 12–13, 14
bitmap graphics, 45
bleed area, 27, 36, 82

Blue-ray discs, 179
Blur filter, 34
Bridge. See Adobe Bridge
browsers. See web browsers
business cards

adding elements, 35–40
adding logo, 35–38
adding text, 35–38
preparing photos for, 32–35

Business Catalyst, 126, 128, 151–152
business stationery, 26–40
buttons

described, 210
vs. hyperlinks, 210
in PDF forms, 259–261

C

cached frames, 187
camera raw images, 88–95
Camera Raw plug-in, 88
captions, 107–108
Clarity slider, 91
clipping mask, 49
clipping path, 101
CMYK color, 278, 281, 295–296
collections, 174–175, 178, 180, 189
color

Adobe Kuler app, 10
background, 64
CMYK, 278, 281, 295–296
edges, 78
fill, 138
images, 280
online media, 281
print media, 281
RGB, 278, 281, 295

color balance, 85–87
color fringing, 78
color grading, 179
color labels, 24–25
color management, 25
color profiles, 35, 282, 286, 295–297
Color Settings dialog box, 25
color spaces, 281, 283
color themes, 10
columns

InDesign documents, 102–104, 241–244
single-column flow, 241–244
splitting/spanning paragraphs, 102–104
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content. See also text
fitting to frame, 222
image, 61–62
page, 57–58
placing, 97, 220–223
viewing. See Content Viewer

Content Collector, 219–220, 221
Content Conveyor, 220–221
Content Grabber, 95
Content Placer tool, 220–223
Content Viewer

previewing apps, 214–215, 228
viewing folios, 224, 225, 228–230

Content-Aware Move tool, 62
contrast, 91
Contrast slider, 91
corner shapes, 111
Creative Cloud

desktop apps, 19
multiple computers and, 16
online storage, 13
subscription, 126, 151, 158, 176, 206
synchronizing application settings, 17
training videos for, 17, 221
using fonts with, 158–167
using video in, 176, 179
website hosting, 15

Crop tool, 33–34, 93, 293–294
cropping images, 33–34, 293–294
crossfades, 186–189
CSS styles, 239–240

D

desktop apps, 19
desktop fonts, 156, 159
developer certificates, 230
Digital Editions. See Adobe Digital Editions
digital negative. See DNG
Digital Publishing Suite. See DPS
Direct Selection tool, 101
DNG files, 90, 278, 291–298
DNG (digital negative) format, 88
documents. See also files

adding metadata to, 23
eBooks. See eBooks
EPUB. See EPUB documents
exporting. See exporting
finding in Adobe Bridge, 69
flattening, 115–117

fonts. See fonts
High Quality Display, 80, 116
iBooks, 213
InDesign. See InDesign documents
links. See linked files
navigating, 70–71
opening in Adobe Bridge, 69, 287
opening in InDesign, 69
saving, 69
templates, 14, 69, 71
viewing in Adobe Bridge, 68–69
viewing in Mini Bridge, 71–72

DPS (Digital Publishing Suite). See also 
publishing

adding interactive elements, 207–211
adding video to iPad apps, 211–213
creating hyperlinks from objects, 

208–211
described, 225
previewing apps on computer, 214–215, 

228
setting up InDesign for, 206–207
updates to, 206

DPS App Builder, 215, 226, 231
DPS Desktop Tools, 225
DPS Single Edition, 215
DPS Tips, 215
Dreamweaver CC, 18
DVDs, 179

E

eBooks, 234–255. See also EPUB entries
online publishing, 241
previewing final version, 253–254
rasterizing page layouts, 244–248, 251
setting up for, 236–239
viewing InDesign document as, 237–239

Edge Code CC, 18
Edge Inspect CC, 18
Edge Reflow CC, 18
editing

frames, 83
in-browser editing with Muse, 152
in InDesign, 83, 108–111
objects, 101, 108–111
in Photoshop, 8
video, 18, 179, 184–185

Embedded OpenType (EOT), 157
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EPUB documents. See also eBooks
adding metadata, 252–253
Adobe Digital Editions, 236
applying object styles, 248–252
considerations, 254
font embedding, 253
mapping text styles to CSS, 239–240
page breaks, 240
previewing final version, 253–254
rasterizing page layouts, 244–248, 251
table of contents, 254

EPUB format
considerations, 241
described, 241
online publishing with, 241
opening documents in, 237–238
vs. PDF format, 241
preparing documents for export, 

239–253
supported reading devices, 236, 241

EPUB standard, 236
e-readers, 236. See also eBooks
errors

linked files, 80
live captions, 108
preflight, 79–80, 120–121

Export as HTML command, 152
exporting. See also importing

documents as PDFs, 122
EPUB export, 239–253
forms to Acrobat Pro, 262–263
graphics for online media, 282–291
graphics for print media, 291–298
social media background, 63–64
video, 200–202

F

Facebook, 13, 14
fades, 186–189
Favorites panel, 22
files. See also documents

adding metadata to, 23
audio, 211–212
color labels, 24–25
DNG, 90, 278, 291–298
exporting. See exporting
JPEG, 286
linked. See linked files
managing, 16
opening in Adobe Bridge, 69, 287

opening in Camera Raw, 89–90
organizing, 172–175
PDF. See PDF entries
PSD, 296, 297
ratings, 24
sharing, 12–13
sorting, 172
synchronizing, 13
TIFF, 286, 296

fill colors, 138
Fill proxy, 50
Film & Video preset, 177
Filter By Name field, 163–164
Filter panel, 24
filtering fonts, 163–165
filters

Blur, 34
Radial, 91–92
Sharpen, 288, 295

Flash Professional CC, 18
Flattener Preview panel, 115–117
flattening documents, 115–117
folders, adding to Favorites, 22
Folio Builder panel, 225–228, 231
Folio Overlays panel, 213–215
Folio Producer, 225
Folio Producer Editor, 225
folios

creating, 225–228
described, 212
offline, 226
previewing, 228–230
submitting, 225
video control options, 212–213
viewing in Adobe Content Viewer, 224, 

225, 228–230
font formats, 156–159
fonts, 154–168

adding/removing, 163, 167
choosing, 156–158
in Creative Cloud, 158–167
desktop, 156, 159
embedded, 253
EPUB documents, 253
filtering, 163–165
glyphs, 156
OpenType, 156, 157, 159
platform issues, 156
PostScript, 156, 159
for printing, 156
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fonts (continued )
recently used, 160
system, 156, 161
TrueType, 156, 157, 159
TypeKit. See Adobe TypeKit
viewing in Adobe Bridge, 69, 160
for websites, 130, 157–158, 160–167

form objects, 267, 270–271
formatting text. See also styles

paragraph styles, 100
while importing into InDesign, 97–99

forms
mobile-friendly websites, 146–150
PDF. See PDF forms

Frame Fitting Options dialog box, 89, 106, 
108–111

frames
Auto-Fit options, 89, 95, 106, 108
cached, 187
corner shapes, 111
editing, 83
fitting objects into, 89, 106, 108–111
overlapping, 83
poster, 212
rendered, 184, 193, 200–202
selecting, 83
threaded, 99
uncached, 187
wrapping text around, 101

FTP service, 152

G

global guides, 30
glyphs, 156
Go to Page command, 128
Google, 14
Gradient tool, 54–55
graphics, 107–108. See also images; objects

bitmap, 45
exporting for online media, 282–291
exporting for print media, 291–298
in Illustrator. See Illustrator CC
logos. See logos
preparing for online media, 282–291
resizing, 89, 108
resolution, 80
vector, 45

grid controls, 41–51
guide-based rule, 216
guides, 88, 130, 133

H

H.264 format, 201, 202, 212
HD (high-definition) video, 183, 201, 212, 

279, 280
HDTV format, 177
HiDPI/Retina displays, 280
High Quality Display option, 80, 116
high-definition. See HD
home page, 128, 129
Horizontal Type tool, 60–61
HTML, 152
hyperlinks. See also linked files

applying to objects, 139–140
vs. buttons, 210
creating from objects, 208–211
described, 210
options, 208–209
renaming, 209

Hyperlinks menu, 139–140

I

iBooks documents, 213
Illustrator CC

adding logo to video, 189–191
artboards, 26–32
creating business stationery, 26–40
overview, 9
package design mockup, 41–51

image content, 61–62. See also content
Image Import Options dialog box, 84–85
Image Trace feature, 45–49
images, 107–108. See also graphics; 

objects; photos
adapting for mobile-friendly websites, 

141–146
adjusting position, 95
background image for social media, 

51–64
camera raw, 88–95
changing dimensions, 291
collections, 174–175, 178, 180, 189
color, 280
contrast, 91
cropping, 33–34, 293–294
dimensions, 297–298
exporting for online media, 282–291
exporting for print media, 291–298
in Illustrator. See Illustrator CC
Import options, 84–85
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inspecting in InDesign, 296–298
navigating through, 172–175
organizing, 172–175
PNG, 64, 230
preparing for multiple media, 276–299
raw, 8, 88–95
resizing, 89, 108
resolution, 117–119, 120, 278–280
Review Mode, 172–175
selecting/deselecting, 173–174
sharpening, 287–291, 294–295
specifications, 298
splash screen, 230
still, 181–184
testing, 291

importing. See also exporting
DNG files, 90
linked files and, 79
multiple photos, 104–106
Photoshop images, 84–85
text into InDesign documents, 96–99
videos, 211–214

InDesign CC
Articles panel, 241–248
creating alternate vertical layout, 

218–224
creating PDF forms in, 258–273
editing objects in, 108–111
inspecting images in, 296–298
links. See linked files
liquid layouts, 216–218
multiple page sizes, 81–82
overview, 11
paragraph styles, 100
previewing pages, 71
selecting/editing frames, 83
setting up to use DPS, 206–207
Show All Menu Items, 70
styles. See styles
templates, 69, 71
updates to, 206
workspace, 70

InDesign documents. See also documents
columns, 102–104, 241–244
entering text, 96
exporting as PDF files, 122
formatting text, 97–99, 100
importing text into, 96–99
linked image resolution, 117–119
live captions, 107–108

marking up text in, 112–115
modifying, 79–115
opening documents in, 69
photo layout, 104–106
preparing for EPUB export, 239–253
preparing for printing, 115–121
saving documents, 69
setting up for print layout, 68–72
templates, 69, 71
tracking text changes, 112–115
transparency issues, 115–117
updating linked files, 79–80
viewing as eBooks, 237–239
wrapping text around frames, 101

Info panel, 297–298
Internet connection, 225
iPad, 206
iPad/iPhone apps, 204–233. See also apps; 

DPS
adding interactive elements, 207–211
adding video to, 211–213
Adobe Ideas, 19
Adobe Kuler app, 10
alternate vertical layout, 218–224
App Store apps vs. iBooks documents, 

213
creating hyperlinks from objects, 

208–211
final production steps, 230–231
folios. See folios
liquid layouts, 216–218
Photoshop Touch, 19
previewing on computer, 214–215, 228
publishing, 225
screen orientation, 216–224, 228, 230
splash screen images, 230

J

JPEG files, 286
JPEG preset, 63

K

key position, 130–132
keyframes, 194–198
keywords, 23
Keywords panel, 23
Kuler app, 10
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L

Lasso tool, 61–62
layer comps, 84–88
layers

animating, 192–198
background, 52, 85
comparing, 84–88
deleting, 183
previewing, 88
video, 181, 182–185, 182–190
visibility, 85, 86–87

Layers panel, 52–54, 83, 136
lines per inch (lpi), 280
linked files. See also hyperlinks

errors, 80
images, 117–119
import issues, 79
resolution, 117–119
updating, 79–80
viewing in Adobe Bridge, 69

LinkedIn, 14
Links panel, 80, 117, 118–119
live captions, 107–108
Lock Guides option, 28
log-in page, 146–150
logos

adding to business card, 35–38
adding to package design, 43
adding to side bar, 59
adding to videos, 189–191

lpi (lines per inch), 280

M

masks, clipping, 49
master pages, 71, 129, 133, 210
media

adding to Photoshop, 178–181
adding to video, 178–181
color requirements, 280, 281
online. See online media
prepararing images for, 276–299
print. See print media
social, 51–64

Media Encoder CC, 179
megapixels, 279
memory, 184, 187

metadata
adding to EPUB documents, 252–253
adding to files, 23
live captions, 107–108

Metadata panel, 23
Microsoft Word, 97–99
Mini Bridge, 71–72, 90, 296
mobile devices

apps for. See apps
compact menus for, 135–140
phone layout, 135–140, 142, 146
preparing graphics for, 282–291
resolution, 279–280, 287
screen orientation, 216–224, 228, 230
smartphones, 157, 206, 254, 279, 280
tablets, 157, 206, 254, 279, 280
websites on. See mobile-friendly 

websites
mobile-friendly websites, 124–153

adapting main image, 141–146
adding compact menu for phone layout, 

135–140
adding forms, 146–150
converting regular websites to, 132–134
designing with Adobe Muse, 126–150
parallax scrolling effect, 130–132
publishing, 151–152

Motion After Key setting, 131
Motion Before Key setting, 131
motion graphics, 179
movies. See video
Muse. See Adobe Muse CC

O

object-based rule, 216
objects

applying hyperlinks to, 139–140
constraining, 134
creating hyperlinks from, 208–211
editing in InDesign, 108–111
editing shape, 101
EPUB documents and, 248–252
fitting into frames, 89, 106, 108–111
form objects, 267, 270–271
grouping, 244–248
liquid layouts, 216–218
original proportions, 134
Paste in Place, 134
predefined, 208
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presets, 267
resizing, 89, 108, 134
restacking, 83
selecting, 252
Smart Objects, 196, 292
styles, 248–252

online collaboration, 12–13
online media

color requirements, 281
exporting graphics for, 282–291
resolution requirements, 279–280

online storage, 13
Open in Camera Raw option, 89–90
OpenType format, 156, 157, 159
overscan, 182

P

package design
adding logo to, 43
adding photos to, 44–51
mocking up in Illustrator, 41–51

page content, 57–58. See also content
Page tool, 81, 217
pages

administrative, 152
Home, 128, 129
log-in, 146–150
master, 71, 129, 133, 210
previewing, 71

Pages panel, 70–71, 81, 218–219
panel arrangements, 24
Panel Options dialog box, 118
panning/zooming video, 192–198
Paragraph Styles panel, 100, 139, 147, 239
paragraphs

splitting/spanning across columns, 
102–104

styles, 100, 139, 147, 239–240
parallax scrolling effect, 130–132
Paste in Place command, 134
PDF files

considerations, 12
containing forms. See PDF forms
exporting InDesign documents as, 122
multiple, 12

PDF format, 241
PDF forms, 256–275

buttons, 259–261
checkboxes, 259–261

combo boxes, 268–269
considerations, 262
creating in InDesign, 258–273
exporting to Acrobat Pro, 262–263
finishing, 270–271
table cleanup, 264–273
text fields, 264–267

Perspective Grid controls, 41–51
Perspective Selection tool, 43, 50, 65
phone layout, 135–140, 142, 146
photography, 18
photos, 107–108. See also images

adding to package design, 44–51
business cards, 32–35
collections, 174–175, 178, 180, 189
cropping, 33–34
importing multiple, 104–106
in InDesign documents, 104–106
laying out in grid, 104–106
resizing, 108
selecting/deselecting, 173–174

Photoshop CC
adding media to, 178–181
creating background layer for social 

media, 51–57
creating videos. See video creation
editing in, 8
entering text in text frames, 60
exporting images for online media, 

287–291
exporting images for print media, 

291–296
overview, 8
presets, 200, 202
removing background in, 72–79
Save for Web, 8, 63, 290–291
Shake Reduction feature, 287–291
working with camera raw images, 88–95

Photoshop files, 84–88, 296, 297
Photoshop Touch app, 19
pixels, 278, 279
pixels per inch (ppi), 117–119, 280, 287, 298
Place dialog box, 85, 97
Plan view, 127, 128, 129, 133
playback resolution, 184
PNG images, 64, 230
portfolio, ProSite, 14
poster frame, 212
PostScript format, 156, 159
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ppi (pixels per inch), 117–119, 280, 287, 298
preflight checks, 79–80, 120–121
preflight errors, 79–80, 120–121
Preflight panel, 79–80, 120–121
Premiere Pro CC, 176, 179
presets

Adobe Bridge, 25
animating video with, 192–194
form objects, 267
grids, 42
JPEG, 63
Photoshop, 200, 202
saving, 42
video, 177

Preview Page in Browser command, 130, 145
Preview panel, 68
print layouts, 66–123

exporting to PDF, 122
modifying InDesign document, 79–115
preparing for printing, 115–121
removing background in Photoshop, 

72–79
setting up, 68–72
templates, 71
viewing reference document, 71–72

print media
color requirements, 281
exporting graphics for, 291–298
resolution requirements, 280

printing. See also print layouts
fonts for, 156
linked image resolution and, 117–119
preflight checks, 120–121
preparing InDesign documents for, 

115–121
transparency and, 115–117

profiles
color, 35, 282, 286, 295–297
preflight, 120–121

ProSite portfolio, 14
PSD files, 296
publishing. See also DPS

iPad apps, 225
Muse websites, 15, 151–152
online, 241
portfolio, 14
via EPUB format, 241
websites, 15, 128, 151–152

R

Radial filter, 91–92
radius options, 74–77
RAM, 184, 187
ratings, 24
raw images, 8, 88–95. See also Adobe 

Camera Raw
Redo command, 87
Refine Edge button, 73, 76
rendering frames, 184, 193, 200–202
Reset Workspace command, 24
resolution

actual, 118–119
considerations, 279
effective, 117–119
full, 298
graphics, 80
images, 117–119, 120, 278–280
linked images, 117–119
mobile devices, 279–280, 287
online media, 279–280
playback, 184
preflight checks and, 119–120
print media, 280
Retina/HiDPI displays, 280
screen, 117–119
types of, 279–280
video, 184

Retina/HiDPI displays, 280
Review Mode, 172–175
RGB color, 278, 281, 295

S

Save for Web tools, 8, 63, 290–291
scale, 216
screen frequency, 280
screen resolution, 117–119
screenwriting tools, 179
scroll effects, 130–132
Scroll Motion option, 131
scroll point, 130
Selection tool, 36–39, 45, 110, 252
Shake Reduction feature, 287–291
sharing files/work, 12–13
Sharpen filter, 288, 295
Show All Menu Items option, 70
side bar, 59–61
site map, 128, 129, 132, 162
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Site Settings section, 152
slug area, 82
Smart Guides, 28
Smart Objects, 196, 292
smartphones. See also mobile devices

apps for. See apps
compact menus for, 135–140
considerations, 157, 206, 254, 279, 280
phone layout, 135–140, 142, 146
preparing graphics for, 282–291
screen orientation, 216–224, 228, 230
websites on. See mobile-friendly websites

social media, background image, 51–64
social networking sites, 14
Sort command, 25
sort order, 25
sound. See audio
static HTML, 152
stationery, business, 26–40
still images, 181–184
storage, online, 13
Story Editor window, 114–115
style mapping

to CSS, 239–240
Microsoft Word, 97–99

styles
applying, 100, 139, 147
CSS, 239–240
InDesign import and, 97–99
mapping. See style mapping
paragraph, 100, 139, 147, 239–240
preserving, 97

synchronizing
application settings, 17
files, 13

system fonts, 156, 161
System Fonts menu, 161

T

tables, PDF forms, 264–273
tablets. See also mobile devices

alternate vertical layout, 218–224
apps for. See apps
considerations, 157, 206, 254, 279, 280
liquid layouts, 216–218
screen orientation, 216–224, 228, 230
websites on. See mobile-friendly websites

televisions, 177, 182

templates
InDesign, 69, 71
ProSite portfolios, 14

text. See also content
adding to business cards, 35–38
adding to side bar, 60–61
entering in InDesign documents, 96
entering in Photoshop documents, 60
formatting, 97–99, 100
importing into InDesign documents, 

96–99
marking up in InDesign documents, 

112–115
pasting, 38
styles. See styles
tracking changes in InDesign, 112–115
wrapping around frames, 101

Text tool, 137, 162
Text Wrap panel, 101
threaded frames, 99
TIFF files, 286, 296
timeline, video, 178, 180, 192
Timeline panel, 178, 182–199
title-safe area, 182
Touch App plug-ins, 19
Track Changes panel, 113–115
training videos, 17, 221
transitions, 186–189
transparency, 115–117
TrueType format, 156, 157, 159
tutorials, 17, 221
TVs, 177, 182
Twitter, 13, 14
Twitter background, 51–64
type foundries, 159
Type tool, 38, 96, 100
TypeKit. See Adobe TypeKit

U

Undo command, 87, 298
Update Link button, 80
Upload to FTP Host command, 152
URLs, 151, 152
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V

vector graphics, 45
video, 170–203

720p, 280
1080P, 177, 201, 212, 279, 280
action-safe area, 182
adding audio, 198–200
adding logo, 189–191
adding media to Photoshop, 178–181
adding to iPad apps, 211–213
animating, 192–198
audio in, 179
building video sequence, 181–185
control options, 212–213
creating. See video creation
in Creative Cloud, 176, 179
Creative Cloud training videos, 17, 221
duration, 184–189
editing, 18, 179, 184–185
exporting, 200–202
fades, 186–189
H.264 format, 201, 202, 212
high-definition, 183, 201, 212, 279, 280
importing, 211–214
logging, 179
motion graphics, 179
optimizing, 179
overscan, 182
panning/zooming, 192–198
pixel dimensions, 177, 180, 183
playing, 212, 213
presets, 177
previewing, 183–184
production, 18
resolution, 184
Review Mode, 172–175
screenwriting tools, 179
setting up for, 172–175
Timeline panel, 182–184
title-safe area, 182
transitions, 186–189
Vimeo, 200
visual effects, 179
widescreen format, 177
YouTube, 200, 201

video clips, 177, 181–185
video creation, 170–203

adding media to Photoshop, 178–181
building video sequence, 181–185

creating Photoshop video document, 
177–178

editing video, 184–185
previewing video, 183–184
setting up for, 172–175
Timeline panel, 182–184

video layers, 182–185
video timeline, 178, 180, 192
Vimeo, 200
visual effects, 179
visual identity materials, 20–65

background image for social media, 
51–64

business stationery, 26–40
organizing work with Adobe Bridge, 

22–25
package design mockup, 41–51

W

web browsers
font issues, 157–158
in-browser editing, 152
previewing web pages in, 130, 145

web DVDs, 179
web fonts, 130, 157–158, 160–167
Web Fonts menu, 160
web hosting, 126, 128, 151, 152
Web Open Font Format (WOFF), 157
Web Safe Fonts menu, 161
websites

administrative page, 152
converting to mobile versions of, 

132–134
creating. See Adobe Muse CC
customized, 14–15
Desktop version, 129
fonts for, 130, 157–158, 160–167
Go to Page command, 128
home page, 128, 129
hosting, 15
log-in page, 146–150
managing, 128
mobile-friendly. See mobile-friendly 

websites
parallax scrolling effect, 130–132
Phone version, 129
Plan view, 127, 128, 129, 133
preparing graphics for, 282–291
previewing, 128, 130
publishing, 15, 128, 151–152
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rearranging pages, 129
site map, 128, 129, 132, 162
site settings, 152
structure, 127
Tablet version, 129
URLs for, 151, 152

white balance, 90
widescreen format, 177
Widget Library, 146
WOFF (Web Open Font Format), 157
Word style mapping, 97–99
work area, 184
workspace, 70

Y

YouTube video, 200, 201

Z

Zoom In command, 130
Zoom Out command, 130
zooming/panning video, 192–198
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